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EXECUTIVE SUMMARY

Transportation planning integrated with considerations of environmental justice and
equity is critical to achieving sustainable and resilient cities by addressing ecological
and social issues. Early exposure to related subjects to young students can help to
raise awareness regarding environmental issues and transportation planning. To raise
awareness and promote the importance of environmental justice in transportation
planning, the research team developed a GIS (Geographic Information System)
workshop focusing on the relationship between the Trinity River, a primary waterway in
the Dallas-Fort Worth Metroplex, and transportation accessibility for high school
students. GIS was selected as an instrument to provide a lesson for transportation
planning in this matter focusing on STEAM education that can help students develop
skills useful to promote their academic success in higher education and future career
success.

The project had three phases that are Curriculum Development & Data Collection, GIS

Workshop & Tutorial, and Exhibition & Course Feedback. Each phase is designed as

follows:
Curriculum Development & Data Collection: The research team developed a
curriculum to teach high school students GIS (ArcGIS Pro) program. The
curriculum was planned to focus on the transportation network and issues related
to environmental justice in the communities along the Trinity River. The GIS
workshop was designed to support the existing course at the partner high school,
so the research team collaborated with the teacher to develop a tailored program
for the existing coursework. The data was collected regarding the course topics
from governmental and official websites to ensure a validated and accurate
analysis of the data.
GIS Workshop & Tutorial: The GIS workshop consisted of tutorials, guest
lectures, and a field trip to provide students with multifaceted experience.
Tutorials are focused on getting students familiar with the interface and learning
different analysis tools. Guest lectures provided opportunities to engage with
practitioners and see real projects utilizing GIS analysis. The field trip provided
an opportunity for students to explore and learn about the Trinity River,
surrounding trail networks, and ecological conditions onsite that have been
discussed in class as they work on creating maps using GIS.
Exhibition & Course Feedback: The work of the students has been displayed
at AD EX (Architecture and Design Exchange), an architectural exhibition space,
to showcase and celebrate their work. The feedback from the participating
teachers and students was collected and informed future considerations for the
GIS workshop.



1.0 ABOUT THE GIS WORKSHOP

The goal of the project was to raise awareness of the importance of environmental
justice in transportation planning by introducing high school students to mapping tools
and data on access to alternative transportation types around the Trinity River in Dallas.
The research team focused on introducing real-world data and topics in GIS that were
relevant to the class projects. To ensure appropriate knowledge transfer, the teachers
from the partner school were partly involved in the curriculum development.

1.1 BACKGROUND AND IMPORTANCE OF THE RESEARCH

Significance of university and high school partnership — Universities are known to
produce high-quality research. However, in most cases, it is published and shared in
higher academic outlets and journals (L6pez Turley & Stevens, 2015). This significantly
reduces its impact on the youth studying in high schools, who would be the future
students at those universities. As a research university, UTA (University of Texas at
Arlington) has access to a variety of resources which includes data, software expertise,
interdisciplinary knowledge of complex problems, and a strong industry network.
Though research-education partnerships are highly beneficial to both partnering
institutions - universities and high schools - it has been cited to be challenging to set up
and difficult to maintain (Snipes, 2006). This project aimed to address the gap in
research universities focusing on publishing research in prestigious journals (Lépez
Turley & Stevens, 2015), rather than applying the research in settings that could benefit
from the knowledge, like schools and youth living in and around Trinity. This helps build
upward mobility.

Unlike a typical university research grant, this project utilized the university-school
partnership to co-create a curriculum with high school teachers. The project utilized data
from an existing research project done at UTA, but also located around the school
context.

Utilizing project-based learning - The DFW (Dallas Fort Worth) metroplex is
experiencing drastic urbanization due to a population boom in the region. This has
resulted in a large amount of impact on natural resources like the Trinity River and the
green spaces around it. To address these urban changes, topics of active transportation
planning around Trinity River are trending. Many neighborhoods, especially in south and
west Dallas, have lacked access to walkable and safe green spaces. The research
team tried to deliver related issues while developing the curriculum.



Engaging the youth with urban challenges around them

As the momentum to make the river accessible increases, this project aims to include
the expectations and interpretation of the youth of Dallas for the future of Trinity River
with their studio projects. Engaging the youth with real-world data on a topic that is
actively being pursued by the city and its residents will help them engage with current
challenges and apply their skills to understand how their education can provide
solutions to the problems surrounding them.

1.2 OBJECTIVES

There are numerous reports that show teaching in transportation planning and
environmental justice varies from state to state and among classrooms (Jelks &
Jennings, 2022). Therefore, this project provided youth with STEAM-supported,
interdisciplinary transportation planning-based topics to supplement what they may or
may not receive in their classrooms. Taking advantage of the design elective available
to students at CityLab, this project integrated the studio curriculum with data gathering
and representation on GIS, and a field trip that focused on observing ways to improve
amenities and access to the Trinity River.

In contrast to a purely conceptual approach to introducing GIS that uses foundational
and standard data that is unrelated to what the students observe around them, this
workshop encouraged students to engage with data and topics that they inferred
required attention. This helped to deepen and foster the understanding of the role of
education in solving real-world problems that they observe, build knowledge of
important terminology of transportation planning, and build a personal experience in
solving problems. Teaching about transportation planning, environmental justice, and
design concurrently with an emphasis on developing buildable solutions helped
students build an in-depth case study of studying their contexts through an
interdisciplinary lens.

The UTA researchers and the participating teachers from CityLab believed that young
people have the knowledge and awareness to identify the issues of importance in their
communities. Allowing the youth to engage with data helps them study the issues that
they observe around them and provides them with tools that help them to create
evidence from their observations. This will result in building their confidence and voice
in civic efficacy. Also, an active learning-based pedagogy has been shown to improve
student engagement, increase academic achievements in STEM (Derevenskaia, 2014;
McCright, 2012), and motivate students to do better by showing the connection of their
learning to a larger purpose (Soper et al., 2015). It will ultimately help to improve
student retention in higher education.



2.0 THREE RESEARCH PHASES

21 CURRICULUM DEVELOPMENT AND DATA COLLECTION

The research team developed a curriculum to promote a multifaceted learning
experience for high school students (See Fig. 1). In the process, the research team
invited the teacher from the partner school and the GIS Workshop instructor to finalize
the curriculum development. It was intended to connect the project’s topic scope to the
GIS data that would be made available for the students and integrated to the GIS
instructor’s class activities and teaching needs. The data on Trinity River, the adjacent
amenities and infrastructure, transportation network, and data relating to environmental
justice were gathered for the project.

During the curriculum development phase, the research team provided the scope of the
data and the type of data available for the DFW region. The partnering schoolteacher
helped to ensure that the data would be suitable for their studio projects and provided
inputs on selecting types of data adequate for the high school students. The GIS
instructor helped to ensure that the scope could be translated to teaching.

The GIS workshop was planned as a four-week training and scheduled to be at the
beginning of the studio classes in Architecture, Environmental Sustainability, and Urban
Planning Paths. To ensure that the findings from the GIS training are used by the
students in their class projects, the team focused on collecting data and creating the
GIS curriculum that informed the studio project’s scope.

‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘
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Figure 1 Project Timeline



2.1.1 Methodology

The scope of the grant primarily focused on developing GIS training and lectures to
address issues concerning transportation and environmental justice for high school
students who set their career goals within STEAM education, especially concerning
urban planning, architecture, and landscape architecture. The methodology used aimed
to provide students with an opportunity to advance their skills to be successful when
they pursue degree programs at higher education institutions and/or professional
careers in the related fields after graduation.

Phase 1 - Curriculum Development & Data Collection

The research team developed a curriculum for GIS training that was integrated into
curricula in multiple disciplines (Architecture, Environmental Sustainability, and Urban
Planning Paths) at the partner high school in collaboration with the teachers (CityLab in
Dallas). The collaborative research team together developed the schedule for a four-
week GIS training that included GIS workshops and lectures from professionals of
related fields (e.g., active transportation planning company, NCTCOG, Trinity Coalition).
The collaborative team discussed the scope of the project and the UTA research team
collected GIS data layers and modified them for convenient use for high school students
accordingly. The organization of the GIS training session is presented in the Curriculum
Structure section below.

Phase 2 — GIS Workshop & Tutorial

The UTA research team coordinated with the partner school to provide GIS training to
students when the new semester started, for the month of September. A total of 30
students participated in the workshop. The UTA research team supervised the overall
schedule, communicated with the faculty at the partner high school, organized lectures
of invited professionals, and ensured the program’s successful implementation. One
designated person with professional knowledge in GIS analysis was hired as a primary
instructor of the GIS tutorials and workshops. There was also a supporting instructor, a
teaching assistant who had ample knowledge in GIS analysis, finishing their master's in
planning from UTA. Guest lectures were provided that were integrated with the GIS
training. The field trip was scheduled after the GIS training was completed to provide
the students an opportunity to observe if their observations and analysis on GIS were
comparable to site observations. The field trip was scheduled at a park that was
accessible to Trinity River, a DART station, a bus stop, and a kayak launch.

Phase 3 Exhibition & Course Feedback

The research team conducted a post-evaluation survey for the teachers and students at
the partner high school to examine the effectiveness of the GIS training program. The
findings are being used to modify and improve the developed curriculum so that it can
be adopted by other similar schools. Also, an exhibition of the student work took place
in March and April of 2022, which highlighted the effectiveness of the GIS transportation
analysis as a context study for the students’ studio projects. The exhibition was
arranged by the research team in collaboration with the staff at the American Institute of
Architects Dallas head office. Lastly, the research team submitted an improved proposal




to the CTEDD grant for the expanded impact that this research has on two other local
high schools that expressed the desire to include GIS training as part of STEAM
education.

2.1.2 Data Collection

The data on Trinity River segments that flow across multiple cities in DFW, shapefiles of
cities of DFW, shapefiles on neighborhood amenities that are adjacent to the Trinity
River like parks, river access points, trails, bus stops and DART rail stops, highways,
and the CDC (Centers for Disease Control and Prevention) vulnerability data for the
neighborhoods adjacent to the Trinity River were downloaded, cleaned, and simplified
during this phase.

A base map was created using some of the shapefiles that were collected for the
training. This base map served as a starting point for the students to engage with the
GIS interface, observe and interact with all the information made available.

About  [Z] Content Legend
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The UTA research team used multiple data sources to create the base map.

1. City boundaries, Trinity River — North Central Texas Council of Government’s
(NCTCOG) data portal was used to download data on city boundaries for the
DFW MSA. Out of all the city boundaries, only those cities through which Trinity
River flows were selected for the base file.

2. DART metro station and metro line data — This dataset was acquired from the
transit agency. Our partnering GIS instructor helped to acquire this dataset from
DART.



2.2 GIS WORKSHOP AND TUTORIAL
2.2.1 GIS Workshop Instructor

The instructor was carefully selected to teach the GIS program. The instructor is a
practitioner who actively works with the GIS program and has the most updated
knowledge in GIS analysis. The instructor was in charge of teaching the GIS program
based on the provided curriculum.

2.2.2 GIS Workshop Guest Lectures

Guest lectures provided opportunities for students to learn about real-world projects and
interact with professionals who utilized the GIS program in their projects. The breadth of
the topics that guest lecturers talked about broadened the perspective of students
learning the GIS program. Each lecture was integrated with one of the GIS tutorial
modules.

2.2.2.1 Guest Lecture 1: The Art and Science of Planning and Design —
Finding Ways through Floodplain and Forest by a Special Projects
Manager at Halff Associates, Inc.

Multipurpose transportation-trail alignments, once prioritized, oftentimes require
feasibility analysis before engineering and landscape architecture construction
documents and specifications can be developed. In working through the
implementation steps for the Trinity Forest Spine Trail that was master planned
during 2013, the Halff teams found using GIS to be a valuable tool for the
alignment study. Incremental, more granular studies such as this have proven to
be a valuable method for vetting the final trail routing, and for helping determine
estimates of potential costs. Bud Melton of Halff Associates, Inc. will share how
their planning and landscape architecture team utilized ArcGIS to evaluate both
the horizontal and vertical alignment opportunities and constraints for this forest
trail connection project.

Figure 3 Floodplain analysis model to determine Figure 4 KCS Rail Trestle Underpass concept
optimum alignment and trail surface elevation



2.2.2.2 Guest Lecture 2: From River of Death to National Water Trail by
Trinity Coalition

The Trinity River is one of the most valued natural assets in Texas. The lives of
everyone living in the Trinity River watershed are intimately connected to the
naturescape of the river, and nature-based tourism is a thriving industry in Texas.
The quality of the water in the Trinity River is pristine, and a safe place for
recreation and fresh-water fishing along the river to the Gulf of Mexico. The entire
Trinity River corridor through DFW (Dallas Fort Worth) is designated as a
National Recreation Area, creating the largest National Recreation Area in the
country.

Joe’s Creek Trash Mitigation Project

GOALS OF THE PROJECT

Share solutions
that can be
applied at a
larger scale.

Identify major ‘
sources of the
trash problem in
Joe’s Creek. 5

easible soluti
to mitigate
uncontrolled
trash.

Figure 5 Location map of launchpads on Trinity Figure 6 Slide representing the projects undertaken by Trinity
River, across the DFW metroplex Coalition to address trash problems in Trinity River

2.2.2.3 Guest Lecture 3: Access and Mobility - Making Transit
Connections Across the Region by a Transportation Planner at North
Central Texas Council of Government (NCTCOG)

Transit planning in North Central Texas is a complex process directly impacting
individuals' access and mobility throughout the region. At a regional level, staff
must collect and evaluate mobility gaps using a combination of both spatial and
anecdotal evidence. The barriers to access are further exacerbated by
environmental justice concerns. Lack of access to transportation often translates
to lack of access to necessities and services such as food, healthcare, or
employment. Coverage does not always provide comprehensive access, with
first/last mile concerns, fare equity, and multimodal trip needs requiring additional
consideration and unique solutions. This lecture will explore these challenges to
coordinating public transportation throughout the region and provide insight into
several initiatives and projects created to address them.



2.2.3 Field Trip

Partnering with Trinity Coalition, an environmental and recreation-based regional non-
profit organization, the research team provided a field trip to a local park in Dallas,
Moore Park. Moore Park is located adjacent to the Trinity River with a river launch,
DART rail station, DART bus stop, and a neighborhood park. On the field trip, students
had the opportunity to do a short kayak trip in the river with the help and guidance of
volunteers from Trinity Coalition. The UTA team developed a field trip observational
survey. Volunteers from the North Texas Master Naturalists brought environmental
educational materials to talk about wildlife, wetland, and nature in general.

./ Dallas Love Locks Bridge
Kayak Launch

Parking

Love, ks Bridge
Kayak Launch

Figure 7 Field trip location: Moore Park

2.3 EXHIBITION AND FEEDBACK
2.3.1 Exhibition

After the GIS Workshop has been completed, students continued to work on their class
projects using the information gathered during the GIS sessions. The exhibition
showcased students’ achievements and provided an opportunity for them to publicly
share their work. The exhibition was held at AD EX (Architecture and Design Exchange)
in Dallas and the opening reception was held with professional partners of the provided
GIS Workshop, design reviewers for the course works at the partner school, teachers,
and parents.



L

Figure 8 Student Exhibition at AD EX, Da/}as Figure 9 Opening Receptio at the Exhibition

2.3.2 Feedback on the GIS Workshop

The research team asked the teachers and students to provide feedback using an
online survey. The teachers were satisfied with the overall GIS Workshop program while
students showed neutral satisfaction. However, most of the comments showed that
students were glad to learn a new program. One student said that he/she appreciated
learning the skill that many of them did not have and got proficient with the basics of the
GIS program after the workshop. Another student said that the GIS workshop was well-
paced and informative. Some students thought that the GIS workshop was “opening
mind” and enjoyed learning new skills. Students who had some concerns thought the
online format made learning the GIS program challenging. Teachers appreciated that
they learned how to connect data to maps in simple ways and work on spatial analysis,
while one teacher thought a supplementary session could be provided for participating
teachers.

10



3.0 LESSON PLANS

3.1 CURRICULUM STRUCTURE

The curriculum focused on providing tutorials of the GIS program for participating high
school students and a multifaceted experience by including other types of education
such as a field trip and guest lectures. The GIS workshop was provided for three hours
per class for four weeks. The tutorials were provided virtually, and guest lectures were
provided either virtually or in person due to the surge of COVID-19 cases at the time of
the project. The research team also provided two additional supplementary sessions
after the GIS Workshop was completed.

MODULE 1: Introduction to the GIS Workshop & GIS Program

Objectives
The lesson introduces the GIS workshop by providing information about the

overall topics and explains what GIS is by providing information about its
importance and the properties of maps created by GIS.

Lecture Content
Introduction
e Scope of the study area.
e Understanding environmental assets and benefits in transportation
planning.
e The procedure of the GIS workshop.

GIS Workshop

What is GIS?

Benefits and resources of GIS

Various kinds of GIS software

Exploration of spatial data types (raster, vector, TIN, etc.)

Scale and its role regarding the importance in mapping and spatial
analyses

e Projection/Coordination system

Class Activities & Assignments
e Open the provided map and explore how to navigate the map.

Class Resources
e ArcGIS map online: https://arcg.is/1uXn9H

11
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MODULE 2: Starting GIS

Objectives
The lesson provides an understanding of how to start using GIS, the program

interface, and the properties of spatial data. It also provides a general
understanding of the DFW region regarding natural resources and transportation
network.

Lecture Content
e Setup amap.
e Understanding the program interface and functions
* Understanding the difference between ArcGIS Pro and ArcGIS Desktop.
* Working with spatial data in ArcGIS (add/delete data, organize data,
create bookmarks, etc.)
* Working with non-spatial data (attributes) in ArcGIS (add/drop fields,
calculate/update fields, create graphs, etc.)
e Spatial data visualization (polygon, line, point)
e Spatial data query/filters

Data view and layout view
Guest lecture 1

Class Activities & Assignments
e Create a basemap.
e Mark the location where your school is.

Class Resources
e GIS layers (modified and clipped by the research team): Trinity River,
Highways, City boundaries in DFW
* GIS References: Shapefile for Trinity River, Highways, and DFW cities
boundaries were downloaded from the NCTCOG data website (data-
nctcoggis.opendata.arcgis.com). Data on DART bus stops, bus lines,
metro stops, and metro lines were acquired from DART.

12



MODULE 3: Working with Spatial Data and Creating a Map

Objectives

The lesson provides an understanding of how spatial data can be created and
modified, and introduces spatial analysis tools regarding their functions and
purposes. It also provides an opportunity to think about accessibility to the Trinity
River and current modes of transportation that can support it.

Lecture Content
e Edit/modify spatial data in ArcGIS
e Edit/modify symbology
e Labeling
o Attribute (join)
e Spatial data (join)

Introduction to spatial analysis tools
Guest lecture 2

Class Activities & Assignments
e Add critical map elements to the basemap from Module 2 considering
access to Trinity River and the transit network.
- Demographics
- Transit routes/stops
- Tree cover
- Land use
- Public transit

Class Resources
e GIS layers (modified and clipped by the research team):
o Block group level socio-demographic data 2016
o DART metro and bus stations
o 2016 land use data
o National Land Cover Database 2016
* GIS References:
o Shapefile land use and socio-demographics was downloaded from
the NCTCOG data website (data-nctcoggis.opendata.arcgis.com).
o Data on DART bus stops, bus lines, metro stops, and metro lines
were acquired from DART.
o Texas Natural Resources Information System (TNRIS) datahub
was used to download National Land Cover data and clipped it to
relevant geography.
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MODULE 4: Working with Spatial Analysis and Exporting a Map

Objectives

The lesson provides exercises in spatial analysis in relation to explored data
layers. It also provides an understanding of how to export the created map to
make it appropriate for analysis and publicly presentable. Students will be able to
examine ground-level accessibility to the Trinity River and trails regarding the site
conditions.

Lecture Content

e Spatial analysis tools
- Clip
- Buffer/Euclidean Distance
- Slope

e Layout (map export)
- PDF
- lllustrator

e Guest lecture 3

Class Activities & Assignments
e Use at least one spatial analysis.
e Improve map style (symbol) to make it legible and concise.
* Observe how people may access the river considering the transit network
and existing trails.

Class Resources
e GIS layers (modified and clipped by the research team):
o Block group level socio-demographic data 2016
o DART metro and bus stations
o 2016 Land use data
o National Land Cover Database 2016
e GIS References:
o Shapefile land use and socio-demographics was downloaded from the
NCTCOG data website (data-nctcoggis.opendata.arcgis.com).
o Data on DART bus stops, bus lines, metro stops, and metro lines were
acquired from DART.
o Texas Natural Resources Information System (TNRIS) datahub was used
to download National Land Cover data and clipped it to relevant

geography.
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EXTRA: Additional GIS Sessions

Objectives
The lesson provides additional GIS sessions for the teachers (online) and the

students (invited to the CAPPA computer lab) due to the delayed class schedule.
The content of the sessions is based on the teachers’ and students’ requests.

Lecture Content
e Loading data layers
e Spatial analysis tools
e Editing the created map (modifying shapefiles, editing symbols)
e Layout (map export)

Class Activities & Assignments
e Go to different websites and download data layers for your project.
» Create/delete data layers as needed.
e Clip the data specific to your site.
e Improve map style (symbol) to make it legible and concise.

Class Resources
e GIS layers (modified and clipped by the research team):
Block group level socio-demographic data 2016,
DART metro and bus stations,
2016 Land use data,
National Land Cover Database 2016
Poverty rate at Block group scale
Percentage of minority at block group scale
e GIS References:

o Shapefile land use and socio-demographics was downloaded from the
NCTCOG data website (data-nctcoggis.opendata.arcgis.com).

o Data on DART bus stops, bus lines, metro stops, and metro lines were
acquired from DART.

o Texas Natural Resources Information System (TNRIS) datahub was used
to download National Land Cover data and clipped it to relevant
geography.

o CDC Vulnerability Index data for 2016 — Poverty rate and percentage of
the minority by block group was clipped and modified from this dataset for
neighborhoods related to student’s studio project teams.

O O O O O O
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FIELD TRIP

Objectives

The lesson provides students an opportunity to observe the site in person using
various methods such as sketching, taking photos, walking along the river and
trails, and flying a drone. It also provides an opportunity for students to measure
and observe what they have created using the GIS program onsite.

Location

Moore Park. The selected location has access to the Trinity River with kayak
launch pads and is adjacent to the Corinth Wetland, which has a significant
ecological value.

Field Activities

» Exploring in the Trinity River: Kayak riding

e Observing the ecology along the Trinity River and trail connections: Online
survey and documentation (photos, sketches)

e Learning ecology along the Trinity River: North Texas Master Naturalist’s
Nature Discovery Trunk regarding wetlands, Trinity River, urban wildlife on
the Trinity River, aquatic plants, riparian environments, runoff, pollution

e Learning how to fly a drone: Observation and documentation of
environmental resources and trail connections

* Please see Appendix A through Appendix C for supporting materials of the Lesson

Plans.
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APPENDIX A

GIS TUTORIAL PREPARED FOR THE PARTNER SCHOOL

A-1. GIS Tutorial for the Workshop

Esri ArcGIS Pro: How-To Guide
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Introduction
This How-To Guide is for setting up a Map Project through ArcGIS Pro. The topics covered in this document include:

¢ How to create a new Map Project

¢ General workspace set up

e Setting up your data

* Ways to add external data to your map

* Using certain tools such as the locate tool and the select by attribute tools
¢ Changing the symbology of map features
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How to Create a New Project Map

¢ Open ArcGIS Pro

e Under the middle column New = Blank Templates = select a new Map

ArcGIS Pro

Open

Recent Projects

L= yﬁﬁ:;?&als\rmmen \MyProjectt.apn

L& FL:R‘F’;[_[E?\L;_M. ct_1\PR_Project_1.aprx

B\ tatnitateriechclyitprectapm
[t RS

= gdzf.r\?fﬂ‘w,.M,n.m-‘x"m-,-ﬂ,..i(-‘ th.aprx

L& rlyupr:‘ﬂtt Documents\AreGIS\Projects\MyProje
(o

MSABoundaryMap_1

CA\Users\kaths\Institute of Urban Studies UTA\Unive...

Open another project

{é} Settings

H £ Type here to search

ArcGIS Pro

New

Blank Templates

Pl = @ [
(i F
e
Map Catalog  Global Local
Scene
r;l Start without a template
5| (you can save it later)

Recent Templates

Your recent templates will appear here

Select another project template

Learn about creating project templates

? = o x
Kathleen
( 2 University of Texas at Ariington
L/ hitps: 5.0
Sign out
Resources
- ~
What's Leam Esri
New Start ArcGIS Academy
= @
Esri Blog Help

Comimunity

<

Coming from ArcMap?

Getting started for ArcMap users
Import an ArcMap document

Migration Guide

Discovery Paths

Learn the basics
Begin with the essentals

* Next, be sure to name your project and to save it in the correct project folder.

Open

Recent Projects

L) :ﬁﬁnr:‘:“lrlf;\MyP—.\_}-- 1\MyProjectT.aprs
Ll ;R.,Pii?;j?:f-‘lng:,pu...‘ {_1\PR_Project

B o ratpriec it
L= C\fopr‘?iunlmw jecti\MyProject aprx
L= P:I}.(:-r,cgidr;,p\\M,,P.AU‘-- t1\MyProjectl.aprx
r—_ MyProject

CAUsers\kaths\Docum ArcGIS\Pre

cts\MyProje...

New

Blank Templates

B %

Mep  Catalog

B

Global Local

Create a New Project

Name | MyProject?
Location | E\CitylabHSGIS

[] Create a new folder for this project

Sign.out
Resources
want 4 (]
What's Quick Leam Esri
New Start ArcGIS Academy
36
(= & G
e $
Esri Blog Help
Eommunity
= -

foming from ArcMap?
ok

Setting started for ArcMap users

Import an ArcMap document

* Optional Step: Once ArcGIS Pro has loaded, login to your Esri Account to be able to access more basemaps,
certain analysis functions, and more.
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3@ New York
yaver UNITED , "
Rarver L oPhiladelphia
STATES St Louk P
San Francisee Washington
g Somi ¥ _Allanta
Dallas
Houston
Monterrey iami
MEXICO Havana

132768252 = =
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Setting Up the Map Workspace

If your map did not appear with the Contents window pane on the left side of the screen, go to View tab 2>
Contents

a. The Contents pane shows users what is being displayed on the map. By default, Esri’s topographic map

will be the first item in the Contents pane. Please look at the two screen captures below.

o= - R T

o MyProject? - Map - ArcGIS Pre 2 — ful X
— _— . -
Ex [ T 5] 51 Add .
x B4 A | =[] ” d
o B0 E »® L X
Comvert  Link Catalog Catalog Contents feoprocessing Python Tasks F Workflow Aviation Indoors ’ ' Navigator Camera
E - views- Pane  View window Manager= = - . -
ink Windows Animation  Device: Scene View Clipping Navigation
o~
jancow et
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r Mawa Montreal
i Taronls
AT PLAINS Chicage o Detroit 3 Boston
49 Naw York
perver UNITTED ¢
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San Franci: Nashington
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MEXTCO Havana
132768252 -|| B 3

+ i 1 119.0838602°W 51.07969 n
ﬂ £ Type here ta search =1 b}
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Drawing Order
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Edit

5

Imagery
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Navigator Camera

Navigation

Next, open the Catalog Pane that can also be found under the View tab.

) Kathleen (University of Texas at Arlingtan
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o Detroit 5 JBoston
20 Naw York
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View Clipping
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Project Portal Favorite ses
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a. The Catalog Pane shows the project folder and other folder connections that will have stored data,
created data, etc. for your project.
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= Il =1 - = ¥
L:J:; LJ 'l_ﬂ ;rj | aal ﬁ \3_ = 7({‘:} 150 Add
Convert Link Reset |Catalog Eatalog Contents Geoprocessing Python Tasks f Workflow Aviation Indoors
F - iews=  Panes=] Pane | View indow Manager> = -
View Link Animation
Contents - a x [Elhip
Z
Y /D i MOV &l
— * s Seattle "3
Drawing Order
4 D Map )"
7] Topographic - Hcado
T pDemver UNITED
STATES  silous
1 Francisco D
Los Angele
3 Dalla
Housion
Monterrey
MEXICO
L £51.3721922°W 48.859. v

1:32,768,252

ﬂ £ Type here to search

22




Setting Up Your Data using Arc Catalog

You will access and set up your external data using Arc Catalog. Arc Catalog allows you to add folder connections, to
preview data, to edit data, as well as to archive and backup your original data.

* Go tothe View tab = click on Catalog View

B OE g5 * 5 MyProject2 - Map - ArcGIS Prc ? - (u] X
Map nsert Analysis View Edit Imagery Share P Command Search (Alt+Q 11 Kathleen (University of Texas at Arlington) ~ *® A
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oY= Lw, =] P = = o " Q) B
Convert Link  Reset Catalod Catalog|Contents Geoprocessing Python Tasks Workflow Aviation Indoors pth D Navigator Camera
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View Link Windoes Animation  Device.. Scene View Clipping Navigation
o
Contents v 2 [ElMap )
X g
P —— 3
T | search L W 4
- g
= By g
=8 K B e & &
= <
Drawing Order 25 T A n\.:\
L P“.“ al

4[F] Map O
P
[¥] World Topographic Map
Dallas
A

&

Houston

e

Monterrey

111,884,972 || B 2 B b | 1,578,366,62W 8,988,780 69N HUS v F ]|

n £ Type here to search

e The screen capture below is the Arc Catalog or Catalog View.
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Insert

Clipboard
Contents -3 x

4| Project
o Maps
& Toolboxes
@l Databases
7 Styles
Folders
7 Locators
4 &% Portal
& My Content

My F

orites

& My Groups

& My Organization
ArcGIS Online

) Living Atlas

Favorites

n £ Type here to search

? - 8 X

Analysis View Imagery Share bel & Kathleen (University of Texas at Arfington) = [® A
+ / Import =¥ Export
0 8 Upgrade ~ Synchronize
New Add Import Data Edit
¢ sort~ \ ! - . ~  Sources B Save As -
Orgarize Create Update Metadata
oo ,
®|E» Project » * ||| =] search Project p
Name Metadata Geography Table
o Maps

& Toolboxes

& Databases Tags
¥ Styles
; ": Summary
7 Folders
# Locators i1
Description

Credits
Use limitations

Extent

Scale Range

6ltems 0 ltems Selected

* Next, double click on Folders to access your folder connections. It should show your project folder and any
other folder connections you have. If you do not see a connection to the GIS Data folder, proceed to the steps

below.

Project Catalog

Insert

> Refresh

Clipbosrd

Contents @ x

4 [ Project
& Maps
& Toolboxes
& Databaces
g Styles
Folders
b @l Locators
- Portal
& My Content
My Favorites
& My Groups
‘W My Organization
ArcGIS Online
) Living Atlas

Favorites

n P Type here to search

MyProject? - Catalog - ArcGIS Pro Mirge 7 - a ¥
Analysis Vi lmagery  Share  Folders P Command Search (Alt+ & Kathleen (University of Texas at Arlington) = (@ A
+ 3, P Limport = Export
=2 (5 Upgrade + & Synchronize
Add Data  Edit
T sort- &2 . . ~  Sources & Save As -
Organize Create Update Metadata
e :
— x - T =
@ = @|[E» eroject » Folders » ||| | search Folders ¥e}
Name Type Date Path

& MyProject2 Folder Connection  9/17/2021 3:01:28 PM  EACityLabHSGIS\M.

Titem 0 ltems Selected

Al E )

8
T

This item cannot have metadata.

* Toadd a new folder connection e.g., GIS Data folder go to
o Add > Folder Connection as shown below.
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o Then, navigate to the CityLab folder with the GIS Data files = Select the CityLab Folder and click OK

- Catalag - ArcGIS Pro Manage ? (u x

o= g O-c-F

Catalog Insert Analysis View Imagery Share Folders p mar srch (Al Q & Kathleen (University af Texas at Arlington) = @ &
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L ArcGIS Online
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Share Folders b= mand Searc & Kathleen (University of Texas at Arlington) = [® A
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x g
Coritents + 0 x| Add Folder Connection &
. @ 5 ®|El» computer » KSTANFORD (F » - 2 ) &
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4 [ Computer Name Type Date
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¢ Your Catalog View should now show (2) folder connections: your project folder and the overall project folder
with the GIS data files.
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B MyProject? Folder Connection  9/17/2021 3:01:28 PM  E:ACityLabHSGIS\M. 3
b i@ Toolboxes
CityLabH5GIS Folder Cannection  8/30/2021 10:32:38 Av  EXCityLlabHSGIS
P gl Darabases
b gz Styles
- This item cannot have metadata
4
b & My Content
b €0 My Favorites
b & My Groups
b G My Organization
b €2 ArcGIS Online
b @ Living Atlas
Favorites
2ltems 0 ltems Selected

H £ Type here to search

e To view the GIS data for this project, double click on the CityLab folder = gisdata folder = GIS Data folder.

=g 9- S = MyProject? - Catalog - ArcGIS Pro Manage ? = (=] x
- Catalog Insert Analysis View Imagery Share Folders P command Se & Kathleen (University of Texas at Arlingtor) = /@ A
vt A .move X Delete = Add To Project W import = Export
Copy =/ Rename 3¢ Rep: Add To Favorites 3 : : a4 L) Upgrade + 4 Synchronize
Pav n ew A ot | Data | Edi
- [ Copy Path = Refresh T Sort~ s Add To Mew Projects : v || Sdirees B save As +
Clipboard Organize Create Update Metadata
o
Contents » 3 x [f]Map 8
B
. © G @®[E > Project » Folders » CityLabHsGIS » [o] [1=] search cisptanrscs B - [[=
4 (B Project =
Name Type Date Path Si Metadata Geography Table g
b g Maps —— ;
& MyProject Folder 9/11/2021 30128 PM  EXCityLabHSGIS\M
b i@ Toolboxes -
archive Folder 9/29/2021 15216 PM  E\CityLabHSGIS\ar, . ) Title
b &5l Databases
L abPrgiect2 Ealder 97912001 21500 PM __F (i sbHeGioCir T = 4o for thi .
b i Styles . — 9 Tags There are no tags for this ite
gisdata Folder 9/6/2021 1257:54PM  E\CityLabHSGIS\gi...
rﬁ, Folders | ! | Summary
» i Locators MyProject] Folder /3072021 10:32:58 Al EXCHyLaDHSGIS\M
—
; Bope w MyProject? - Catalag - ArcGIS Pro Manage g i
m Catalog  Insert  Analysis  View  Imagery  Share  Folders E-e Search (/ £ Kathleen (University of Texas at Arfington) = @ &
ut A nove X Delete = Add To Project f:]' Joimport = Expont
Cor # Rename 5 Repain 7k Add To Favorites =~ % B Upgrade ~ & Synchronize
aste 0y New Add Import Data Edit
« [ copyPath = Refresh $ Sort~ Add To New Projects | = g - Sotirces B save As -
Clipboard Qrganize Create Update Metadata
| = Caalog | g
Contents Mip. &
- - T T T o
R T © = @®|El» Project » Folders » CityLabHSGIS » gisdata » * |W||l=| search gisdota 2]
Project -
- - s Fereh M Metad. Geography Table 2
b Maps [ P £
| = oisData Folder 9/6/2021 125806 PM_ EXCityLabHSGI\gl. | w
b Toolboxes L 1 . -

* Now you will see the GIS data for your project in the Arc Catalog View.
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BEGe-c- s MyProject? - Catalog - ArcGIS Pro Manage 7 - g X

- Catalog  Insert  Analysis  View  lmagery  Share  Folders B Command

h (Alt+< &) Kathleen (University of Texas at Adington) = [® A

Cu Remov Dele! Add To Proje y b import = Export
Reviarme: 5= Repai T Faviorite . I Upgrade » ] Synchronize
s Open oy New i Import | Data Edit
- P = Refresh 3 Sort - ki Ty M Proge & . o (e B Save As -
Clipboard Organize Create Update Metadata
; o
Contents >0 x [Elmap Tl
i e © 5 @ |El» Project » Folders » CityLabHSGIS » gisdata » GIS Data Search GIS Data p a
=i Project =
: M Name Type Date i Metadata Geography Table 2
aps e f
. g Vs [E Census_Block Group_2010:shp Shapefile 8/30/2021 5:55:22 PM  EACityLabHSGIS\gi *
& Toolboxes " “ =
a Tt “r] DART Bus_Routes.shp Shapefile 8/30/2021 5:54:58 PM  EACityLabHSGIS\gi. INO l1te
& Databases
b &7 Styles =) DART Bus Siops.shp Shapefile 8/30/2021 5:53:42 PM  EACilyLabHSGIS\gi. Tags There are no tags fo P
o
t[5y Folders =) DART Rail Lines:shp Shapefile 8/30/2021 5:54:34 PM  EACityLabHSGIS\qi Summary
T %} DART_Rail_Station.shp Shapefile 8/30/2021 5:53.00PM  E\CityLabHSGIS\gi.
28 ol ) DFW_Highways.shp Shapefile 8/30/2021 55416 PM  EACityLabHSGIS\gi. —
Description
b @ MyContent &) Parks:shp Shapefile 8/30/2021 5:52:20PM  EACityLabHSGIS\gi
I My Favorites .
Credits
bG8 My Groups % 5
P ‘g My Organization
b ArcGIS Online Use limitations
b @ Living Atlas ! ! !
b Favorites Extent
Scale Range
“

7ltems 0 Items Selected

n £ Type here to search

* Toview and explore the data files, click once on each and use the right-side window pane to explore the
Metadata, Geography, and Table.
o Metadata provides a description of the data if the author made it available.
o Geography shows you where the data is located and how it will appear on your map. From the
geography tab, you can begin to visualize the data, determining if the data is a point, line, or polygon.

G 5 MyProject? - Catalog - ArcGIS Pro Catalog View  Manage ? = o X

Catalog | Insert  Analysis  View  lmagery  Share Preview Folders P Command Search (Ait+G ) Kathileen (University of Texas at Arington) + @ A

Remave X Delete

Project Li—:; / Jimpot =3 Expont
&

B copy / Rename 7% Repa del To Favorit (& Upgrade = 1] Synchronize
. " oy New Add Import | Data Edit
[ Copy Path w Refresh T Sort - Add To New Proj 2 < £ PR & Save As ~
Clipboard Organize Create Update Metadata
Contents -~ 8 x [ElMap >

@S @®|El» Project » Folders » CitylabHSGIS » gisdata » GISData  ~ |0|| 1= Search 615 Data

sws01 Bojeiey

4 [ Project
>R M Name Type Date Path 51 Metadata Geography Table
laps = B
B Census_Block_Group_2010:shp Shapefile 8/30/2021 555:22 PM  EA\CityLabHSGIS\gi o =
b @ Toolboxes ot .
=) DART_Bus_Routesshp Shapetile 8/30/2021 55458 PM EACityLabHSGIS\qi
b i Databases &
=) DART Bus_Stops.shp Shapefile 8/30/2021 55342 PM  EACityLabHSGIS\gi
b il Styles
= ap 2 5:54: HSGIS\gi...
v [5m Folders = DART _Rail_Lines.shp Shapefile 8/30/2021 5:54:34 PM  EACityLabHSGIS\qi
b g Locators =*) DART Rail_Station.shp Shapefile 8/30/2021 5:53:00 PM  E\CityLabHSGIS\gi
4 @ portal =) DFW_Highways.shp Shapefile 8/30/2021 5:54:16 PM  EACityLabHSGIS\gi...
b @ My Content ) Parks.shp Shapefile B/30/2021 55220 PM _ EACityLabHSGIS\gi..
p My Favorites
b %8 My Groups
b @ My Organization
b = ArcGIS Online
b @ Living Atlas
: Favorites
« »

7ltems 1 item Selected

o And Table shows the additional attributes for the data such as FID (the GIS unique ID), name, location,
length, area, etc.
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= The columns represent the attribute categories; in the case of parks: FID, Shape, County, etc.
= The rows represent each feature; in the case of parks: each park.

EEge- e s MyProject2 - Catalog - ArcGIS Fro Manage ? — (u ] X
m Catalog Insert Analysis View Imagery Share Folders R Com (Al & Kathleen (University of Texas at Arlington) * [® &
Cu Remove X Delete LQ‘ & import =P Export
E]Ccpy = # Rename Repai il % Cﬂungmde' E}Synchmnize
Paste Open oy New Add Import | Data Edit
[ Copy Path ¥ Refresh T Sort~ o = x % oA B save As -
Clipboard Organize Create Update Metadata
o
Contents Map L
&
§ i ®© 2 @ [E » Project » Faiders » CitylabHSGIS » gisdata » GIS Data -0 |l—_‘5mn'h IS Data o]
Name Metadata Geography Tabl §
v i@ Maps ks g
i [ Census Block Group_2010.shp :
b i@ Toolboxes ) FID Shape* OBJECTID | COUNTY COG_LU CNTYCODE CATEGORY  Shape.S.. Sha. | Shapeleng Shape Area
(] DART_Bus_Routes shp l
b i Databases = 1 o | FD Jhnson 170 251 Parks/recreatic 38094031 04222 | 832800127 41732133692
[) DART_Bus_Staps:shp 5 s
= 2|1 | Tpe Ject 1D Spnson 170 251 Parks/recreatic 56735977 54701 | 694718828 24296982275
| ) DART_Rail Linesshp Dofaul:  <Nulls
3|2 | Readiiily Ves jhnson 170 251 Parks/recreatic 31730630 62069 | 162064162 1643476417
i =) DART_Rail Station.shp .
b i Locators Sl Nuatie No fhnson 170|251 Parks/recreatic 39270961 54441 | 1903577635 189420931888
Z = ; Indexed:  No
o Pptal (=) DFW._Highways.shp .
5 5 4 Required:  Yes Jrrant 170 439 Parks/recreatic  22.680991 88815 | 1127.316729 77535823323
b & My Content |@| Parks shp. r F
6 5 | Polygon 6453 Tarrant 170 439 Parks/recreatic 48293583 64896 38426516 45723866
b
by Favaritas 7 6  Polygon 7443 | Johnson | 170 251 Parks/recreatic | 60.054461 19982 | 623.32702  24097.592946
b
My iougn 8 |7 Polygon 7820 | Tarrant 170 439 Parks/recreatic 68550159 61013 | 2000.022625 | 33632.381231
b G My Organization -
9 |8  Palygon 8819 | Tarrant 170 439 Parks/recreatic 74064314 85615 | 3239.506457 60250179636
b €3 ArcGIS Online
e 109  Polygon 9168 Tarrant 170 49 Parke/recreatic 32.548412 83616 707.102164 11159577007
@ Living Atlas
4 11 10 | Polygon 9553 Tarrant 170 439 Parks/recreatic 03220675 35663 | 1358581137 76505846991
b J Favarites
2 n Polygon 10053 | Tarrant 170 439 Parke/recreatic 36344917 62653 165749425 1702002116
13|12 Polygon| 10054 | Tarrant 170 439 Parks/recreatic 89.880529 85097 | 720.069215 17866206721
14 13 Palygon 10055 Tarrant 170 439 Parksrecrentic 47453763 S60A1 | 2499 075464 | 182373494789
A A @E M 0of 8738 selected -— + 100% - |

Tltems 1 Item Selected

Backing Up Data in Arc Catalog

After view the data files, we will back-up or archive these original data files in a new folder. It is important to back-up
data files whenever working on an official project. It is possible that files can get corrupted or accidentally deleted,

therefore it is best to save a copy in case this scenario happens.

CIRIG)

[+ Project » Folders » CitylabHSGIS » gisdata » GIS Data

-0

Create the new backup folder by either going to New = Folder or right clicking > select New Folder
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BB ES s MyProject2 - Catalog - ArcGIS Pro Manage ? - (= I ¢
- Catalog | Insert Analysis View Imagery Share Folders P Command Search (Alt+0) & Kathleen (University of Texas at Arlington) = (@ &
T et % Remove X Delete + Add To Project Ea / Jimport = Expart
Copy # Rehame G Repai - AdYTo Fivorites = [E: Upgrade = B Synchronize
Paste Open oy Add Impaort | Data Edit
- (i) Copy Path = Refresh $ Sort=  Add To New Projeds . & | Sonmad B> save As ~
Clipboard Organize e Folder Metadata
- — o
Contents -0 x M O File Geodatabase AR
P @@ @[> Project + Folders| = Mobile Geodatabase ~ [ [12] search gisdata 2] 8
4 [ Project - - & ool L
e b Name oalox Fath Metadata Geagraphy Table g
laps —_
b i ool W GIs Data & 2ythonToolbox 21125806 PM  EACitylabHSGIS\gi... L]
/ OXES p -
: ) LAS Dataset No Title
b igl Databases 5 Gaseachage
b 3 Styles (:r e Tags Thereate no tags for this item
=) Shapefile
Summary
There is no summary for this item
Description
b & My Content There is no description far this item
v D My Favorites "
Credits
b & My Groups I
here are no credits for this item
b @ My Organization
Y8 Aretiis Onine Use limitations
b @ tving Atls There are no access and use limitations for this item
b Favorites Extent
There is no extent for this jtam
Scale Range
There is no scale range for this item
-
1ltem 0 items Selected

Rename the folder GIS Data Backup then return to the original data files as shown in the two screen captures below.

? = a X

EEBEe-o- = MyProject? - Catalog - ArcGIS Pro Manage
_ Catalog \ Insert Analysis View Imagery Share Folders P Command Search (Alt+Q) & Kathleen (University of Texas at Ariington) = /@ A
Cut lz * Remove X Delete 4 Add To Project ":(I 8/ / Vimport = Export
Copy | 7 rarame’ i nesie Je-Add e avontes = 4 1@ upgrade - &) synchronize
Paste Open . New Add Import Data Edit
~ [ Copy Path > Refresh & Sort* i Add To New Projects > s = Sources & Save As +
Clipboard Organize Create Update Metadata.
= 2
Contents crx Ewe TR >
5
WL e © 5 @|[E > Project » Folders » CitylabHSGIS » gisdata » - [ [12] search gisdata . [
b Name Type Date Path Metadata Geography Table g
laps e 8
E ¥ GIS Data Folder 9/6/2021 125806 PM  E\CityLabHSGIS\gi... -
b i@ Toalboxes e T
¥ 5 Bwabasss \=1 GIS Data Backup Folder EACityLabHSGIS\gi...
Eage-co- - MyProject2 - Catalog - ArcGIS Pro Manage ? - 7 X
Catalog | Inset  Analysis  View  Imagery  Share  Folders P Command Search (Alt+Q) £ Kathleen (University of Texas at Arlington) = /@ A
= i X Remove X Delete + Add To Project JJ} / Jrimport = Export
g - N 2 | - .
; Rename 2% Repair Add To Favorites = > @Upgrade - &1 Synchronize
Paste Open oy New Add Import  Data Edit
G ¥ Refresh T Sort~ Add To New Projects v 2t Stuites & Save As ~
Clipboard Organize Create Update Metadata
Contents -0 x [Elvap [l - g
s i ® 2 @[E » Project » Folders » CitylabHSGIS » gisdata » GisDam = |O)| [1=] search 615 Dara 2| é
b g M Name Type Date Path Metadata Geography Table g
laps. = _ s
S I Census_Block_Group_2010:shp Shapefile 8/30/2021 55522 PM  EA\CityLabHSGIS\gi... 2
b T— -
& Db (&) DART Bus_Routesshp Shapefile 8/30/2021 554:58PM  EACityLabHSGIS\gi... No Title
atabases
o ks [ DART_Bus_Stops.shp Shapefile 8/30/2021 55342 PM  ENCHWYLabHSGIS\. | Tags There are no tags for this item
DART _Rail_Lines.shy Shapefile 8/30/2021 5:5434 PM  EACityLabHSGIS\gi...
_Rail | P P ity S\gi Summary
b i@l Locators [%) DART_Rail_Station.shp Shapefile 8/30/2021 5:53.00PM  E\CityLabHSGIS\gi... st 4
2 Pare DFW_Highways shp Shapefile 8/30/20271 55416 PM  EA\CityLabHSGIS\gi bsciibil
i . ) scription
s (5\ My Content [ED Parks shp Shapefile B8/30/2021 5:5220 PM  EACitylabHSGIS\gi... eraieidbatiition el i

Next, select all the GIS files (shift + click the first and last file) and Copy files using either Control + C OR using the Copy
command on the left-hand side.
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e aar = MyProject2 - Catalog - ArcGIS Pro Manage ? - o
IR oo | et s View  imagery  Shae  Folders P Command Search (Alt+0) & Kathleen (University of Texas at Arlington) = /@ A
! X Remove X Delete + Add To Project ¥ S, Jrimport = Export
= Rename {7 Repair 1 Add To Favorites T . T upgrade * & Synchronize
Open New Add lmport Data Edit
W] Copy Path = Refresh  $ Sort = Add To New Projects % 23 % Shilias B> Save As ~
Clipboard Organize Create Update Metadata
Contents cox Flwe  [EXTONEY ‘
e ©@|E » Project » Folders » CityLabHSGIS » gisdata » GisData || [J=] search Gi5 Data |
4 [ Project
Name Type Date Path
F g Maps
N [ Census_Block Group_2010.shp Shapefile A730/2021 55522 PM_ EACitylabHSGIS\gi...
O OXes
s [) DART_Bus_Rouites.shp Shapefile B/AD/2021 55456 PM  EACityLabHSGIS\gi...
() DART Bus Stopsshp Shapefile 8/30/2021 55342 PM
DART Rail Lines.shp Shapefile 8/30/2021 5:54:34 PM
- e Multiple items are selected,
b '#f Locators & Ll Sunahe Stapefte bl gl Select one item to view its metadata,
S o DFW._Highways.shp Shapefile 8/30/2021 55416 PM_ EACityLabHSGIS\gi...
b @ My Content 12 Parks.shp Shapefile B/30/2021 5:5220PM _ EACityL gl

b Mu Faunritac

Next, navigate back to your GIS Data Backup folder, open the folder, and paste the files either using Control + V or the

X

aexe  Bojerey

Paste command on the left-hand side. This process may take a few moments depending on the number of files and file

sizes.

Once you see the data files in the folder

LSl — = R R

Paste
- Copy Path

Cliphoard

Opes

Contents.

4 = Project
b gl Maps
b @ Toolboxes
P il Databases
b igE Styles

odes ]

b @ Locators
4 @ Portal
b @& My Content
b 3 My Favorites
P 48 My Groups
b @ My Organization
b € ArcGIS Cnline
b @ Living Atlas

b Favorites

= MyProject2 - Catalog - ArcGIS Pro

Insert Analysis View Imagery

X Remove ete Add To Project

Renama 3% Repair Add To Favorites
= Refresh  § Sort =

Organize

Add To New Projects

Manage

Share
A

14 ¥

New Add Import

Folders

Create

ou have successfull

R Command Search [Alt+0Q)

@ / Jimport = Export
D.!: 'Eait Upgrade = a Synchronize
a
Sources B Save As -
Update Metadata

archived/backed

our data.

2 -

a

© 5 @|[E« Folders » CitylabHsG1s » gisdata » GIS Data Backup

vEJ—I

1= | search 615 Data Bockup

Name

[E Census_Block_Group_2010:shp
() DART_Bus_Routes.shp

[5) DART Bus Stops shp
DART_Rail_Lines.shp

[E2) DART Rail Station.shp
DFW_Highways.shp

[E) Parksshp

Type

Shapefile
Shapefile
Shapefile
Shapefile
Shapefile
Shapefile
Shapefile

Date

B8/30/2021 5:55:22 PM
873042021 5:54:58 PM
873042027 5:53:42 PM
8/30/2021 5:54:34 PM
873072021 5:53:00 PM

Path
EACityLabHSGIS\gi...
EACityLabHSGIS\gi...
E\CitylabHSGIS\gi
EA\CityLabHSGIS\gi...
EACityLabHSGIS\gi..
EACityLabHSGIS\gi...
EACityLabHSGIS\gi...

8/30/2021 5:54:16 PM
8/30/2021 5:52:20 PM

7ltems 0 |tems Selected
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Metadata Geography Table

No Title
Tags Therea ags for this item
Summary
e is no summary for this itsm
Description
here is no description fo
Credits
There

Use limitations

and use limitations for this item

e are no access

Extent

There is na extent for this iter

Scale Range

There is na scale range for this item
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& Kathleen (University of Texas at Arington) = /@ A
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Adding Data to Your Map
There are several ways to add data to your map. The two ways that will be discussed are and 1) Adding data directly
from the ArcCatalog View and 2) Adding data through the Catalog Pane. However, before adding external data, it is
important to first select a Basemap.

Selecting a Basemap
* Before adding external data to your map, first select the desired or the appropriate basemap for your project.
a. Go to the Map tab, click on the Basemap icon and view and browse Esri’s collection of default Basemaps
b. Note: Unlike ArcGIS Desktop, which can show multiple Basemaps layers, ArcGIS Pro only shows one
Basemap layer per Map project.

B . Sl MyProject2 - Map - ArcGIS Pro Layer 2 - o X
Project nsert Analysis View Edit Imagery Share Appearance R and  (Alt+Q ) Kathleen (University of Texas at Arlington) * ™ A
g 2 m - b BB add Preset - r o (R B %z A dud [
b ] . Add Graphics Layer R i % £
Explore Bookmarks Go pdd Select Select By Select By Measure Locate Infographics Coordinate Convert
- . To XY - Attributes Location - - - Conversion  #3~ -
Clipboard Navigate " e = foity Labeling o
Contents -3 x [ElMap X ] % =l T (Catalog v BX
Imagery Imagery with Labels Strests
T | search pel Project Portal Favorite ss
- 1 [X] o . i | Search Project P
<\ :
p—— #h
& Maps
: T
Drawing Order ‘ Giwa
& Toolboxes
4 [F] map . "
AL Dark Gray Canvas Light Gray Canvas b & Databases
[ Gpensireeihap G
-
ot i H Folders
od I, e New York .
wrian b i@ Locators
}f era ®
Gl Washington
Terrain with Labels
] X,
Y
BRI A %t:,. o
USGS National Map USA Topo Maps
i . México T y The Bahamas =l
LaHabana®
132768252 ~|| B 7k B <} | 98,9639579°W 49.9405900°N ¥ | nie

n £ Type here to search

Adding Data to Your Map using Arc Catalog View
e Open the Arc Catalog View from the View tab
* Navigate to your GIS Data files from the folder connections
* Select which data will be added to your map
* To add the data to your map, right click = Add Data to Map (screen capture below)
o This will add the data to the current map selection
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X

= o1 - = MyProject2 - Catalog - ArcGIS Pro Manage
Catalog  Insert  Analysis | View | Imagery  Share  Folders B & Kathleen (University of Texas at Adington) = [® A
mE e OF - =) D Detat Pl
¢ - = =) Display Type =
Reset Catalog Catslog Contents Geoprocessing Python Tasks Workflow Aviation Indoors  ltem
Panes* Pane  View window Manager= = - Popups+ )
Windows Options Device Location &
v EXEE] g
Contents 0 x| EMp T
= y g
S P ® = @®|FE» Poject » Folders » CitylabHSGIS » gisdata » GiSData  ~ |O)|| |2 | Search GiS Data o .| ‘i
Name Type Date Path g
b g Maps 3
) Census Block Group 201 — B/30/2021 555522 PM  EACityLabHSGIS\gi. =
& Toolboxes el ¥, 54 To iap
“r] DART Bus_R h B/30/2021 5:54:58 PM  EACityLabHSGIS\gi...
b fgi Databases """ 270 To New >
Styles (") DART_Bus_ Stops.shp | B/30/2021 5:53:42 PM  EACityLabHSGIS\qL..
P =] DART_Rail_Lines.shp Export " | B/3072001 5:5434 PM  EACityLabHSGIS\GL..
: @ c | e R S Multiple items are selected
b i@ Locators DART_Rail_Station.shp &l Copy 8/30/2021 5:53:00 PM  EACityLabHSGIS\gi... St Tt e T Pt
4 @ Portdl DFW_Highwaysshp X Delete . 8/30/2021 5:54:16 PM  E\CityLabHSGIS\gi...
e E
b @ My Content () Parks shp B/30/2021 55220 PM  EACityLabHSGIS\gi..
b €20 My Favorites
b G My Groups
b ‘gl My Organization
ArcGIS Online
b @) Living Atlas
: Favorites
an
Titems 7 ltems Selected

ﬂ £ Type here to search

* Toggling back to the Map tab, the selected data should now appear on your main project map. You may now

close the Arc Catalog View tab.

B MyProject2 - Map - ArcGIS Pro bl Ly

BE @S-

il = =]

£ Kathieen (University of Texas at Arlington) = (@~

Map Insert Analysis View Edit Imagery Share Appearance Labeling Data P Comman
i B 08 O = = D = : 2 Add o [0
Vi | = — x .
R D 0OEBEE i ¥ :
Convert Link Reset Catalog Catalog Comtents Geoprocessing Python Tasks Reviewer Workflow Aviation Indoors h D
[l map Views= | Panesv Pane  View window Rules Managerr = - ity M
View Link Windows Animation Scene View Clipping
Contents -0 x Y
Y |s »p
, ]
E pr .
Drawing Order
4[] map 1
4[] DART_Rail_Station
°

4[] DART_Bus_Stops
L]

4[] DPW_Highways

4[] DART_Rail Lines

4[] DART Bus_Routes

4[] Parks
|
4[] Census_Block_Group_2010

Wit Tanaaranhic Man v 11278303 -||H L

A
H P Type here to search

Adding Data to Your Map using the Catalog Pane

2,493,531,95E 6,919,079.54N RUS ~

* |nthe Catalog Pane (right window), expand the Folders icon.
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a.

E e - 3 Map
Map Insert Ar
a -
1 Fl
Lo & EL
... ([ :
Explore "™ “™ Bookmarks Go  Basemap Add
S - ToXY - Data~
Clipboard Navigate i Layer
Contents - x| |[Elvap
Search b

Phoenix
Los Angeles

H pel Type here to search

L]
so using the Catalog Pane.

a.

G Add Graphics Layer

MyProject2 - Map Pro
Insert Analysis View Edit magery
O )| =3
L L
Explore ” "~ “* Bookmarks Go  Basemap Add
X <« = To XY v Jata~
Clipboard Navigate Layer
. ]
Contents v 1 x| NN
Y | search J-]
1) 'r e
Drawing Order
 [E] Map
/| OpenstreetMap
151,200,394 T -

n 0 Type here to search

&%, Add Graphics Layer

| Add Preset -

Cokageis

Under Folders, your Project folders and files will be shown.

Select Select By Sel

- Attributes Location - - C
Selection g
Ottawa
New York
Washington

The Bahamas

La Habana'®

Next, we will add a new Folder Connection
b. Right click on Folders in the Catalog Pane = click Add Folder Connection

Measure Locate Infographics

Select Select By Select By

nquiry

Washesgton

L Habiana®
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Optional Step: If you were not able to set-up your folder connections through the Arc Catalog View, you can do
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* Select the folder of interest, in this case the CityLab folder.
Once the folder is added, you will see it in the list of Folders.
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Next, we will add GIS data shapefiles to the map.

a. Shapefiles — spatial data represented by vectors that come in the form of points (places), lines (lengths),
and polygons (areas); the files end with .shp.
b. Go to your Catalog Pane = Folders = Expand the gisdata folder - Expand the GIS Data folder = Click
and Drag the ‘Parks.shp’ shape file onto the Map
i. Note: Adding the data may zoom out your map extent; using your mouse, zoom back in
c. The parks.shp will now show up on your map and also in your Content Pane on the left
d. Repeat this process to add data to your project
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Changing Data Symbols (Symbology)

Changing your maps data symbols is a critical for visualization. Appropriate color schemes and symbols help you to
create a meaningful map for both you and your audience.

Changing Layers to Commonly Used Symbols

e To make your map more intuitive, go to your catalog panel on the left side of your screen and click once on one
of the symbols of your layers. This will bring up the Symbology panel on the right side of your screen.
o For layer such as DART_Bus_Stops, you might want to use a symbol of a bus. To do this, click on the

EludosCcesdEaIasRAACEGCE T BO

Gallery tab, in the Symbology panel and search “bus.” Various options will appear. Choose the one you
feel is most fitting. You can change other symbols by scrolling through the gallery or searching in the
specific type of icon you are looking for.

To change the color of the symbol, click on the Properties tab in the Symbology Panel, click the
paintbrush icon, and, under appearance, change the color.
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e For layers that have multiple categories based on the attributes, you can designate a specific color to each
category. For instance, DART_Rail_Lines have 5 different lines—LRT Blue Line, LRT Green Line, LRT Orange Line,
LRT Red Line, and Trinity Railway Express. Each of these lines can be represented by the color of the rail line.

e To change these types of categories, click once on one of the symbols of your layer. The symbology panel will
appear on the right side of your screen.

e]

O
o
(o]

Click on the back arrow “€” on the top left of the symbology panel.

Under “Primary Symbology” click “Unique Values”

For “Field 1” select “NAMES”

In the “Classes” chart, you will see 3 columns as shown below. Click on the individual-colored line you
want to change the color of.
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Classes I Scales

— -

LRT Blue Line

LRT Green Line

~ LRT Orange Line

4

LRT Red Line

Trinity Railway E...

v <all other values>

— -

<all other value...

o The “Properties” tab will come up. Make sure the paintbrush option is selected. Under “Appearance”

change the color and line width.
o Click “Apply” at the bottom of the panel.

o Click the back arrow “<” to return to previous pane. Repeat for all necessary components.
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ArcGIS Pro Tools

The Locate Tool
* Next, we will locate the general project location.

a. This can be done in several ways — in this case, we will start by using the Locate function in the Map tab

under the Inquiry tools.
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Using the Select ‘By Attribute’ Tool & Queries

e Select Map = Select by Attributes then in the Geoprocessing panel on the right side of your screen, choose
your Input Rows. Next, choose new selection in selection type, then choose your expression. Click Run at the
bottom of the panel.
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o Ex1.Inputis DART_Bus_Stops and the expression is “Where CITY is equal to DALLAS.”
= Using this attribute selection will show you all of the bus stops in Dallas and where they are
located, as shown in the screenshot immediately below.
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Using the Select Attribute By Location Tool
e Select Map = Select by location. Geoprocessing panel will appear on the right side of the screen. Insert Input
feature(s), relationship, selecting features, and distance (if needed). Selection type is New selection. Click
“Run” in the bottom right of the geoprocessing panel.

Geoprocessing »3x
® Select Layer By Location &)
Parameters Environments @

Input Features (%)
[ DART_Bus_Stops -] -
[ -] e

| Within a distance -|

Selecting Features
Parks “- -

Search Distance

wfea

Selection type
New selection '|

[linvert spatial relationship

o Ex. We want to know how many DART bus stops (input feature) are within a distance (relationship) of a
park (selecting feature) with a search distance of 300 feet. The resulting map search is below.
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Solution: Only 1 bus stop!

Can we reverse the process?
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The same solution which is the same (1) bus stop!
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A-2. GIS Tutorial: How to Export to PDF

How to make Layout on ArcGIS Pro
+ Open ArcGIS Pro and data file
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To add a layer on the layout, Click Insert tab > Map Frame > Layer
= |f you made bookmark for your area, use bookmark.
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+ Specify the area to put the layer
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+ Click Insert tab, insert North Arrow, Scale Bar, and Legend
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+ Right click on the map, and click Activate
= You can pan, zoom in and out on Activation mode
« Use your mouse or Navigate button under the Activated
Map Frame tab
* Click Close Activation button on Activated Map Frame tab to hetwbon
exit Activation mode Wi Bl .
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+ If you want to convert the map to a specific scale,

= Select or enter the scale you want to convert
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Right-click on the map > Properties > Format Map Frame > displayed second icon > Scale
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Customise

decreasing the size of the scale bar

The number of scale bar’s scale numbers are also converted, and the numbers can be changed by increasing or
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+ If you want to change the map units, double-click on scale bar > Properties > Map Units
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+ If you want to change text properties, right-click on text(ex. L d) > Text Symbol > App e.

= You can change other properties under Text Symbol window, for example, Position, Rotation, Halo,...
* When you finish setting the properties, click Apply
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+ To convert your layout to PDF file format, Click Layout icon under the Share tab
= Set File Type PDF
= Designate location
= Select Convert character maker symbols to polygon

= Select PDF Layers and Feature Attributes &
= Confirm Export Completed message

e =8 x | Export Layoul
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Properties Sex Properties <

v il ~ Resalution

EXport Layout %
Laysut]

Properties Security

~ Resalation

a bl

How to edit polygons in Adobe lllustrator

= Open file in Adobe lllustrator
* Remember the saved location

* Desktop

1214 Projectsample

v EThis PC
38 Desktop

L3 Documents

¥ Downivads
B Music
B Videos
o5 )

Filename: LayoutSample pdf

Al Formats (* Ak AIT* POF,* D}

Open Cloud Document Open Cancel
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= Select all (Ctrl + A) and right-click on polygons, select Ungroup

ansiom
drmmge

Selct

e o Ubrary
Colect Tar fport
Fepon Secton

13

= Select all(Ctrl + A) again and right-click on polygons, select Release Clipping Mask
= See the changes in the layer

RN AENS AN IR EOEEREHEE

14

51



1/21/2022

= Select specific polygon which you want to change the color.
= Click Select > Same > Fill Color. The marked color was selected

o s
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e
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Suske Color
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o e ke ol

= Double-click Fill icon and choose the color to change
* See changed result below
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= To select the stroke, click the Direct Selection icon((A), white arrow) and move over to the desired location,
and click.
= Click the Selection icon((V), black arrow) and double-click the stroke icon to change colors

Selection (V)

Direct
Selection (V)

17

= You can change stroke width in the Properties tab

18
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= To save the file as PDF, click File tab > Save a Copy...
= Enter the file name and click Save
« Set the Adobe PDF Preset and Save PDF
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Set the Color Model to CMYK for printing
Set Resolution High (higher than 200 ppi)
Click OK to save the file
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APPENDIX B

DEMONSTRATION OF GIS WORKSHOP

B-1. GIS Workshop: Preparation & Demonstration

T
i

Figure 12 Desk Crit at CityLab Figure 13 GIS Workshop at CAPPA, UTA
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B-2. Field Trip

PR .’ { et ; - 3
Figure 16 North Texas Mater Naturalist Figure 17 Walking along the River

Figure 18 Learning River Ecology Figure 9 Dron Lesson
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[Online Survey for Field Activities]

eld Trip to Mo Park 5. Dt_ascribe th_e conditions of the river and the river bank based on the
following questions.

Is the water in the river clean? Do you see any trash? s the river bank eroded? Is the river bank
Document few of your observations about Trinity River and Moore Park with this survey steep or gentle? Does it have trees/shrubs/prairies? Do you see any insects/fish/animals?
Does the river look safe to get in? How much vegetation do you see along the river bank?

What is your first impression of the Trinity River today?

1000

1000
’ Walk around a little bit and take a picture of something that you like.*
This can be a picture of any features (plants, trail, river, bridge, launch pad, others) that you
2. How often do you visit the Trinity River or parks adjacent to the were happy to see
river? Which part of the river have you visited? What are the names of
the parks you visited?

Select image file

Describe the picture you tock and why you like it

1000 ,

3. Take alook at the conditions of the river and the river bank and
take a picture of it.* 1000

These pictures should help us understand the edge condition between the river and the land.

Walk around a little bit and take a picture of something that you don't
like.**

This can be a picture of any features (plants, trail, river, bridge, launch pad, others) that you
were not happy to see

Selectimage file

4, Take another picture of the river conditions.

This picture will be more specific of the river itself Select image file

Describe the picture you took and why you didn't like it

1000 ,

1000

10. What activities do you want to do at the river or around the river?
How clean is the river and the edge at this location?

1 star would indicate a lot of trash, 5 star would indicate that itis very clean

How did you get to the park today
Choose all that apply How would you rate this river edge location?

Write your reflection about today's visit to the river and activities we
did.

Public Transit

walk

1000
Bike

What other transportation do you think you can use to get to this
location? Choose all that applies.
Choose all that applies

Bike trail

walking

public transit
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B-3. Exhibition at AD EX, Dallas

\

/g

Figure 21 Stuent Presentation  Figure 22 Board D;'splay

|

Figure 23 Architectural Models Creatéd by Students

B e
Figure 24 Installation in Progress
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APPENDIX C

COLLABORATING PARTNERS
C-1. Participated Teachers from the Partner School, The CityLab

Oswaldo Rivera-Ortiz, Architecture, CityLab

Jennifer Sayed, Urban Planning, CityLab

Ashley Gardner, Environmental Sustainability, CityLab
Lynn Smith, Principal, CityLab

C-2. UTA Graduate Research Assistants

Kathleen Stanford, Graduate Research Assistant, Institute of Urban Studies, City and
Regional Planning

Dasom Mun, Graduate Research Assistant, Landscape Architecture Program

Avery Deering-Frank, Graduate Research Assistant, Landscape Architecture Program

C-3. GIS Workshop Instructor

Ali Behseresht is a Ph.D. student of Urban Planning and Public Policy at the University
of Texas at Arlington (UTA). He was teaching ArcGIS introduction, intermediate and
advanced level classes to students at UTA’s Urban Planning and Public Policy program.
Also, Ali is a public transit Project Manager at Dallas Area Rapid Transit (DART). He
manages public transit facilities, oversees Automatic Passenger Counter (APC) in
collecting ridership, and analyzes ridership for further changes/improvements in public
transit infrastructure.

His experience in teaching and research interests in Geographic Information Systems
(GIS), Quantitative Modeling, land-use modeling, and public transit provided significant
inputs in creating most impactful teaching material for students, using real-world data.
For example, Ali acquired bus stop amenities, and user count data from DART. This
data was immensely helpful in determining the best locations for bus stop interventions.

C-4. Guest Speakers

W.J. “Bud” Melton engages with Special Projects in Halff's Planning and Landscape
Architecture practice. During his nearly-30 years of consulting, he has had key roles in
alignment feasibility studies, and fostering inter-jurisdictional and interagency
partnerships for a variety of urban bikeways and trails which are included in the planned
Regional Veloweb network. Bud is a member of the American Planning Association and
its Texas Chapter; the Association of Pedestrian & Bicycle Professionals; the Urban
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Land Institute’s TOD Product Council; a board director of the Greater Dallas Planning
Council. He serves on advisory councils for University of Texas at Arlington’s master's
in landscape architecture Program as well as for Dallas Independent School District’s
CityLab High School Foundation.

Steve Smith's early career as a rocket scientist in the Neil Armstrong lunar landing
program equipped him well to found Smith Group Asset Management, specializing in
finding companies that will grow faster than expected and capturing the reward for
clients when that happens. Steve has always loved the outdoors. He attained the
highest honor awarded, an Eagle Scout, in Boy Scouts of America and spent five
summers volunteering in BSA camps. In recent years, his love of the outdoors has led
him to volunteer for a number of nature-oriented non-profits, including recent board
seats for Groundwork Dallas, Friends of Reverchon Park, Audubon Texas, and the
Trinity Coalition, where he currently serves as Board Chairman.

Teresa Patterson, aka “River Mom” is a certified ACA (American Canoe Association)
instructor, and co-owner of Adventures Unlimited Paddling Company. She worked as an
event planner/decorator and author before turning her talents to growing the Trinity
River Paddling Trail. She has been guiding groups of paddlers on adventures
throughout the rivers and lakes of the DFW Metroplex for over 6 years. She currently
serves as an officer in the North Texas River Runners and is an active member of the
Dallas Downriver Club. Originally a scuba diver, Teresa took up kayaking as a way to
stay close to the water when she couldn’t dive. Now kayaking, sailing, and horseback
riding are her passions. The only thing she loves more is helping others discover the
joys of nature on the river.

Kristi Kerr Leonard possesses a lifelong love of the natural world, starting with her
childhood in the woods and creeks of Oak Cliff, and now merges that with her MBA and
business acumen. Utilizing her MBA from Thunderbird School of Global Management,
Kristi began her career as an account supervisor at The Richards Group and later
operated her own advertising company, Head Bank Freelance Advertising. Most
recently, she served as a consultant to high-net worth individuals in their estate
management and legacy building. Kristi found her niche in 2014 as a certified North
Texas Master Naturalist. A natural explorer, Kristi’s primary volunteer activity is leading
hikes in the Great Trinity Forest. Her research focus includes local history, medicinal
and edible plants, forest ecology, and Native American lore.

Rachel Jenkins joined the North Central Texas Council of Governments (NCTCOG) as
a Transportation Planner in 2019. As part of the Transit Management and Planning
team she plans, implements, and supports transit projects and mobility management
activities throughout the region. Together with regional transportation partners, she
works to identify and address transportation gaps and opportunities. Prior to joining the
team at NCTCOG, Rachel managed the group visit program as part of the University
Recruitment team at the University of Texas at Arlington, assisting students on their
journey to higher education. Rachel received her Bachelor of Arts Degree in Geography
and Anthropology from Texas Christian University in 2014 and a Master of City and
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Regional Planning with a Certificate in Geographic Information Systems from the
University of Texas at Arlington in 2020. In 2019, she was named an Eisenhower
Transportation Fellow by the U.S. Department of Transportation for her research and
professional contributions to the field of transportation. She is also a steadfast advocate
for public transportation and mobility access within her own community in Fort Worth,
Texas.

C-5. Field Trip Volunteers

Teresa Patterson, Trinity River Paddling Trail Manager, Trinity coalition, Adventures
Unlimited Paddling Company

Kristi Kerr Leonard, MBA, Trinity Coalition

Ginger Greatens, North Texas Master Naturalists

Imelda Haley, North Texas Master Naturalists

C-6. Project Partners

The CityLab High School Foundation is an independent nonprofit organization that
supports the mission of CityLab High School. The Foundation promotes community
involvement and secures funding support for the High School. Foundation programs
include Dallas Mayoral Forums, annual Summits, and webinars. The Foundation also
helps connect CityLab with potential project and funding partners.

The Trinity Coalition is dedicated to improving the Trinity River, its parks, and forests,
as one of the most valued natural assets in Texas. In 2020 they were rewarded with the
official designation of the Upper Trinity River Corridor as a National Water Trail, creating
a national paddling destination for our 7.4 million Dallas-Ft Worth Metroplex residents
and the nation. It is a 501(c)3 non-profit corporation.

The Institute of Urban Studies (IUS) was founded in 1967 to conduct research on
urban issues, provide the fruits of that research to municipal government organizations,
educational institutions, and community non-profits, and to train future generations of
urban planners, city officials, and academic leaders. Over the past 50+ years, the
Institute has assisted over 300 Texas communities from small general law cities, to
neighborhoods, to major cities like Dallas and Fort Worth. IUS has generated millions of
dollars of sponsored research and community-based projects and helped to train
hundreds of planning professionals and city leaders who have applied their skills to
assist communities and educational institutions across the nation. IUS is housed with
UT Arlington, a Carnegie Tier 1 research institution based in the Dallas Fort Worth
Metroplex.
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